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¦ǾƻŘ 

 

U ovom radu je opisan eksperiment telemetrijske stanice u poljoprivredi, koja mjeri temperaturu, 

ǾƭŀȌƴƻǎǘ ǾŀȊŘǳƘŀ ƛ ǾƭŀȌƴƻǎǘ ȊŜƳƭƧƛǑǘŀΣ ǘŜ ǇƻŘŀǘƪŜ ǑŀƭƧŜ ǎŜǊǾŜǊǳ IoT tima, kakav je ThingsSpeak, kako bi 

se mogli pogledati na bilo kom mjestu putem interneta i povratno reagovati. PǊƛƳƻǇǊŜŘŀƧƴƛƪ őƛƴŜ 

dva mikrokontrolera WiFi LoRa 32(V2)Σ ǇǊƻƛȊǾƻŚŀőŀ Heltec, koji su opremljeni protokolom za 

komunikaciju LoRaΦ wŀŘƛ ǎŜ ƻ ǊŀŘƛƧǎƪƻƳ ŦǊŜƪǾŜƴŎƛƧǎƪƻ ƳƻŘǳƭƛǎŀƴƻƳ ǎƛƎƴŀƭǳ ƳŀƭŜ ǇƻǘǊƻǑƴƧŜΣ ǇƻǎŜōƴƻ 

namijenjenom IoT ǳǊŜŚŀƧƛƳŀΦ 

tǊǾƛ ǳǊŜŚŀƧ ǊŀŘƛ kao prijamnik-posrednik, u dometu je WiFi ƳǊŜȌŜ ƛ ǇƻǾŜȊŀƴ ƧŜ ǎŀ ThingSpeak 

ǎŜǊǾŜǊƻƳΦ hƴ ƧŜ ǇƻǎǊŜŘƴƛƪ ǳ ƪƻƳǳƴƛƪŀŎƛƧƛ ǎŜǊǾŜǊŀ ǎŀ ŘǊǳƎƛƳ ǳǊŜŚŀƧŜƳ ǇǳǘŜƳ LoRa ƳǊŜȌŜΣ ƪƻƧƛ ǎŜ 

nalazi dalje izvan dometa WiFi ǎƛƎƴŀƭŀΦ bŀ ǎǾƻƳ ŜƪǊŀƴǳ ǇǊƛƪŀȊǳƧŜ ƛƴŦƻǊƳŀŎƛƧŜ ƻŘ ȊƴŀőŀƧŀΦ 

DrǳƎƛ ǳǊŜŚŀƧ όǎǘŀƴƛŎŀύ ǎŜ ǎŀǎǘƻƧƛ ƻŘΥ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊŀ WiFi Lora 32(V2) ǎŀ ǎŜƴȊƻǊƻƳ ǾƭŀȌƴƻǎǘƛ ƛ 

temperature DHT11, ǎŜƴȊƻǊƻƳ ǾƭŀȌƴƻǎǘƛ ȊŜƳƭƧƛǑǘŀ ŘƻƳŀŏŜ ǇǊƻƛȊǾƻŘƴƧŜΣ ǎƻƭŀǊƴŜ ǇƭƻőŜΣ ŀƪǳƳǳƭŀǘƻǊŀ ƛ 

elektronskog kola za regulaciju napajanja. 

aƛƪǊƻƪƻƴǘǊƻƭŜǊƛ ǎǳ ǇǊƻƎǊŀƳƛǊŀƴƛ ǳ ǊŀȊǾƻƧƴƻƳ ƻƪǊǳȌŜƴƧǳ Arduino IDEΣ Ȋŀ ƪƻƧŜ ǇƻǎǘƻƧŜ ȊǾŀƴƛőƴƻ 

ǇƻŘǊȌŀƴŜ ōƛōƭƛƻǘŜƪŜ ƻŘ ǎǘǊŀƴŜ ǇǊƻƛȊǾƻŚŀőŀΦ 

{ǘŀƴƛŎŀ ǑŀƭƧŜ ǇƻŘŀǘƪŜ ǇǊƛƪǳǇƭƧŜƴŜ ƻŘ ǎŜƴȊƻǊŀ ǇǊǾƻƳ ǳǊŜŚŀƧǳ ǇǳǘŜƳ ǇǊƻǘƻƪƻƭŀ LoRa; dok on 

ǇƻŘŀǘƪŜ ǇǊƻǎƭƧŜŚǳƧŜ ǎŜǊǾŜǊǳ ǇǳǘŜƳ WiFi ƳǊŜȌŜΦ hƳƻƎǳŏŜƴŀ ƧŜ ƛ ǇƻǾǊŀǘƴŀ ƪƻƳǳƴƛƪŀŎƛƧŀ ƴŀ ȊŀƘǘƧŜǾ 

ǎŜǊǾŜǊŀΣ ǘŀƪƻ Ǒǘƻ ǎǘŀƴƛŎŀ ǇǊƛƳŀ ƪƻƴǘǊƻƭƴŜ ǾǊƛƧŜŘƴƻǎǘƛ ƪƻƧŜ ǎŜ ȊŀŘŀƧǳ ƴŀ ǎerveru, i u skladu sa tim 

ǇƻƪǊŜŏŜ ƛƭƛ ƻōǳǎǘŀǾƭƧŀ ƻŘƎƻǾŀǊŀƧǳŏŜ ǊŀŘƴƧŜ (npr. upravljanje sistemom za navodnjavanje ili 

ƻŘǊȌŀǾŀƴƧŜ ǾƭŀȌƴƻǎǘƛ ƛ ǘŜƳǇŜǊŀǘǳǊŜύΦ Yŀƻ ǊŜȊǳƭǘŀǘ ǎǳ Řŀǘƛ ƎǊŀŦƛőƪƛ ǇǊƛƪŀȊƛ ǇǊƻƳƧŜƴŜ ǘŜƳǇŜǊŀǘǳǊŜ ƛ 

ǾƭŀȌƴƻǎǘƛΣ Ǒǘƻ korisnicima ƳƻȌŜ Řŀǘƛ ōƻƭƧi uvid u stanje na poljoprivrednom imanju i, u skladu s tim, 

ōƛƭƧƪŜ ƳƻƎǳ Řƻōƛǘƛ ƻŘƎƻǾŀǊŀƧǳŏƛ ǘǊŜǘƳŀƴΦ 

tǊǾƻ ǇƻƎƭŀǾƭƧŜ ƻǇƛǎǳƧŜ ŦƛȊƛőƪƻ-funkcionalne cjeline sistema. U drugom poglavlju su opisane 

ǘŜƘƴƛőƪŜ ƪŀǊŀƪǘŜǊƛǎǘƛƪŜ ƪƻǊƛǑŏŜƴƛƘ ǳǊŜŚŀƧŀ ƛ ƻǇǊŜƳŜ, s posebnim osvrtom na sistem za napajanje i 

softversku pripremu rada sa mikrokontrolerom. U ǘǊŜŏŜƳ poglavlju su dati osnovni podaci o 

ǇǊƻǘƻƪƻƭǳ [ƻwŀΣ őƛƧŜ ǎǳ ƻǎƻōƛƴŜ ȊƴŀőŀƧƴŜ Ȋŀ ƻǾŀƧ ǇǊƻƧŜƪŀǘΦ ¦ őŜǘǾǊǘƻƳ poglavlju je opisana 

internetska platforma ThingSpeak koja je ȊŀǎƭǳȌƴŀ Ȋŀ ŘŀƭƧƛƴǎƪƻ ǇǊŜƎƭŜŘŀƴƧŜ ƛ ǳǇǊŀǾƭƧŀƴƧŜΦ Peto 

ǇƻƎƭŀǾƭƧŜ ǎŀŘǊȌƛ ǇƻŘŀǘƪŜ ƻ ƴŀőƛƴǳ ǊŀŘŀ ƪŀǇŀŎƛǘƛǾƴƛƘ ǎŜƴȊƻǊŀΣ Řƻƪ ƧŜ ǳ ǑŜǎǘƻƳ ƻǇƛǎŀƴ ƪƻǊƛǑŏŜƴƛ 

postupak kalibracije. Sedmo ǇƻƎƭŀǾƭƧŜ ǎŀŘǊȌƛ ƻǇƛǎ ƛ ǳǇǳǘǎǘǾƻ ƛȊǊŀŘŜ ǑǘŀƳǇŀƴƛƘ Ǉƭƻőŀ ¦± ƳŜǘƻŘƻƳΣ 

kojim je proƛȊǾŜŘŜƴŀ Ǉƭƻőŀ Ȋŀ ƪŀǇŀŎƛǘƛǾƴƛ ǎŜƴȊƻǊΦ U posljednjem, osmom poglavlju, prikazani su 

rezultati mjerenja u vidu grafika i tabela. 
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L hǎƴƻǾƴŜ ŎƧŜƭƛƴŜ ǎƛǎǘŜƳŀ  
 

{ƛǎǘŜƳ ǎŜ ƳƻȌŜ ǇƻŘƛƧŜƭƛǘƛ ƴŀ ǾƛǑŜ ŦǳƴƪŎƛƻƴŀƭƴƛƘ ŎƧŜƭƛƴŀ ƪƻƧŜ ǎǳ ƳŜŚǳǎƻōƴƻ ǇƻǾŜȊŀƴŜ ǳ ƧŜŘŀƴ 

ǎƭƻȌŜƴƛ ǎƛǎǘŜƳΣ ƪŀƻ Ǒǘƻ ƧŜ ǇǊƛƪŀȊŀƴƻ ƴŀ ǎƭƛŎƛ мΦм. {ŜƴȊƻǊƛ ǇǊƛƪǳǇƭƧŀƧǳ ǇƻŘŀǘƪŜ ƻŘ ȊƴŀőŀƧŀ ƪŀƻ Ǒǘƻ ǎǳ: 

ǘŜƳǇŜǊŀǘǳǊŀΣ ǾƭŀȌƴƻǎǘ ǾŀȊŘǳƘŀΣ ǾƭŀȌƴƻǎǘ ǘƭŀΣ ƛƴǘŜƴȊƛǘŜǘ ǎǾŜǘƭƻǎti itd. i ǑŀƭƧǳ ƛƘ ƴŀ {¢!bL/¦ ƪƻƧŀ ǎŜ 

sastoji od: nodeMCU όƳƻŘŜǊƴƛ ǳƳǊŜȌŜƴƛ ƳƛƪǊƻǇǊƻŎŜǎƻǊύΣ LoRaWAN komunikacionog modula, 

aktuatora i prednjeg kraja senzora, napajanja zasnovanog na autonomnom sistemu solarnih baterija 

ƛ ƛȊƭŀȊƴƻƳ όǇǊŜƪƛŘŀőǳύ ƳƻŘǳƭǳΦ tǊŜǘƘƻŘƴƻ ƻōǊŀŚŜƴƛ ǇƻŘŀŎƛ su poslati putem LoRaWAN-a 

DALJINSKOM KOLEKTORU, koji dalje putem WiFi-ja i rutera (hot spot) komunicira sa CLOUD-om, na 

kojem su integrisane komercijalne IoT platforme poput ThingSpeak, IFTTT. Kao rezultat, izmjerene 

ǾŜƭƛőƛƴŜ ǎŜ ƳƻƎǳ ǇǊŀǘƛǘƛ ǇǳǘŜƳ interneta bilo gdje i bilo kada, analizirati i povratno reagovati. 

 

Slika 1.1: Funkcionalne cjeline sistema 

 

PǊƛƴŎƛǇƛƧŜƭƴŀ ǑŜƳŀ ǎǘŀƴƛŎŜ je data na slici 1.2. 
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Slika 1.2Υ tǊƛƴŎƛǇƛƧŜƭƴŀ ǑŜƳa 

 

hƴƻ Ǒǘƻ ǎŜ ƴŀ ǇǊǾƛ ǇƻƎƭŜŘ ǾƛŘƛ ƧŜǎǳ ŘǾŀ ǳǊŜŚŀƧŀ ƛȊƳŜŚǳ ƪƻƧƛƘ ǎŜ ƻŘǊȌŀǾŀ ōŜȌƛőƴŀ ƪƻƳǳƴƛƪŀŎƛƧŀ 

ǇǳǘŜƳ ƳǊŜȌŜ LoRaWAN. 5Ŝǎƴƻ ƧŜ ǇǊƛƪŀȊŀƴ ƳŀƴƧƛΣ ǇǊƛǊǳőƴƛΣ ǳǊŜŚŀƧ őƛƧƛ ǎǳ ƎƭŀǾƴƛ ȊŀŘŀŎƛ ǾŜȊŀ ǎŀ 

ǎŜǊǾŜǊƻƳ ƛ ǇǊƛƪŀȊƛǾŀƴƧŜ ǘǊŜƴǳǘƴƛƘ ǊŜȊǳƭǘŀǘŀ ƳƧŜǊŜƴƧŀΦ bƧŜƎƻǾ ǎƻŦǘǾŜǊ ǾƻŘƛ Ǌŀőǳƴŀ ƻ protokolu za 

komunikaciju i o sinhronizaciji. 

¦ǊŜŚŀƧ ǇǊƛƪŀȊŀƴ ƭƛƧŜǾƻ ǇǊŜŘǎǘŀǾƭƧŀ ǎǘŀƴƛŎǳ ƪƻƧŀ se nalazi napolju. Ima isti softverski dio, i razlikuje 

ǎŜ Ǉƻ ƘŀǊŘǾŜǊǎƪƧ ƛƳǇƭŜƳŜƴǘŀŎƛƧƛΦ bŜƻǇƘƻŘƴƻ ƧŜ ōƛƭƻ ƻōŜȊōƛƧŜŘƛǘƛ ƴŀǇŀƧŀƴƧŜΣ Ǒǘƻ ƧŜ ǳǊŀŚŜƴƻ ǇƻƳƻŏǳ 

ǇǳƴƧƛǾƻƎ ŀƪǳƳǳƭŀǘƻǊŀ ƛ ǎƻƭǊƴƻƎ ƛȊǾƻǊŀ ŜƴŜǊƎƛƧŜΤ ǘŀƪƻ Řŀ ƳƻȌŜ Řŀ ǊŀŘƛ ǎŀƳƻǎǘŀƭƴƻ ǘƻƪƻƳ ŘǳȌŜƎ 

vremena. Kontrolna ŜƭŜƪǘǊƻƴƛƪŀ ƧŜ ȊŀŘǳȌŜƴŀ Řŀ ǘŀƧ Řƛƻ ǊŀŘƛ ƛǎǇǊŀǾƴƻΣ Ǒǘƻ ƧŜ ŘŜǘŀƭƧƴƛƧŜ ƻǇƛǎŀƴƻ ǳ 

poglavlju 2.2.1. 

{ŜƴȊƻǊƛ ƻǎǘǾŀǊǳƧǳ ǾŜȊǳ ǎŀ ǎǇƻƭƧŀǑƴƧƛƳ ǎǾƛƧŜǘƻƳΣ ƛ ƻǾŘƧŜ ǎǳ ǳǇƻǘǊƛƧŜōƭƧŜƴŀ ŘǾŀ ǎŜƴȊƻǊŀ ƪƻƧŀ ƳƧŜǊŜ ǘǊƛ 

ŦƛȊƛőƪŜ ǾŜƭƛőƛƴŜΦ tƻǑǘƻ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊ ƛƳŀ ƻǎŀƳƴŀŜǎǘ ŀƴŀƭƻƎno-ŘƛƎƛǘŀƭƴƛƘ ƪƻƴǾŜǊǘƻǊŀΣ ƳƻƎǳŏŜ ƧŜ 

ǇǊƛƪƭƧǳőƛǘƛ ƴŀƧǾƛǑŜ ƛǎǘƻ ǘƻƭƛƪƻ ǎŜƴȊƻǊŀΦ bŀ ǎƭƛŎƛ мΦн ƧŜ ǇǊƛƪŀȊŀƴ ŦƛȊƛőƪƛ ƛȊƎƭŜŘ ǇƻƧŜŘƛƴŀőƴƛƘ ŘƧŜƭƻǾŀ 

sistema. 
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{ƭƛƪŀ мΦнΥ {ǘŀƴƛŎŀ ǳ ǾƛƴƻƎǊŀŘǳ όƭƛƧŜǾƻύΣ ǇǊƛǊǳőƴƛ ǳǊŜŚŀƧ όŘŜǎƴƻύ ƛ ǳƴǳǘǊŀǑƴƧƻǎǘ ƪǳǘƛƧŜ ƴŀ stanici (ispod) 
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LL ¢ŜƘƴƛőƪŜ ƪŀǊŀƪǘŜǊƛǎǘƛƪŜ 

 

2.1 Heltec WiFi LoRa 32(V2) 

tƻƪǊŜŏŜ Ǝŀ ŘǾƻƧŜȊƎŀǊƴƛ ǇǊƻŎŜǎƻǊ ESP32 sa taktom od 240 MHz (Tensilica LX6 dual-core). 

Opremljen je: WiFi, Bluetooth i LoRa ǎǘŀƴŘŀǊŘƛƳŀ Ȋŀ ōŜȌƛőƴǳ ƪƻƳǳƴƛƪŀŎƛƧǳΣ ǎŀ ƎƻǊƴƧƻƳ ƎǊŀƴƛŎƻƳ 

izlazne snage od 19dB za komunikaciju putem protokola LoRaΣ ǎŀ ƴŀȊƴŀőŜƴƛƳ ŘƻƳŜǘƻƳ ƻŘ рƪƳΦ 

Mikrokontroler posjeduje tri UART kola (universal asynchronous receiver-transmitter) za serijsku 

komunikaciju, po dva SPI (serial peripheral interface) i I2C (inter-integrated circuit), I2S (inter-ic 

sound); osamnaest dvanaestobitnih ADC ulaza i dva osmobitna DAC izlaza, 22 GPIO (general-purpose 

ƛƴǇǳǘκƻǳǘǇǳǘύ ƛ ǑŜǎǘ GPI pinova. Raspored pinova je prikazan na slici 2.1. 

Ima 8MB SPI Flash memorije i 520KB interne SRAM memorije; jedan mikro USB ǇǊƛƪƭƧǳőŀƪΣ IPEX 

ǇǊƛƪƭƧǳőŀƪ Ȋŀ ŀƴǘŜƴǳ ƛ ǳƪǳǇƴƻ ос ǇƛƴƻǾŀ Ȋŀ ǇƻǾŜȊƛǾŀƴƧŜ ǎŀ ǎǇƻƭƧŀǑƴƧƛƳ ǳǊŜŚŀƧƛƳŀΦ LƳŀ ƛ ǳƎǊŀŚŜƴƛ 

OLED ŘƛǎǇƭŜƧ ǾŜƭƛőƛƴŜ лΣфс ƛƴőŀΦ 

tƻǘǊƻǑƴƧŀ ǎǘǊǳƧŜ ǳ ǊŜȌƛƳǳ deep sleep ƛȊƴƻǎƛ уллҡ!Σ Řƻƪ ǎŜ ǊŀŘƴŀ ǘŜƳǇŜǊŀǘǳǊŀ ƪǊŜŏŜ ǳ ƻǇǎŜƎǳ ƻŘ -

40 do 80 °C. 

Slika 2.1: Dijagram pinova 

tƻ ƪŀǊŀƪǘŜǊƛǎǘƛƪŀƳŀ ȊƴŀőŀƧƴƻ ƴŀŘƳŀǑǳƧŜ ǇƻǇǳƭŀǊƴŜ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊŜ !ǊŘǳƛƴƻΣ Ǒǘƻ Ǝŀ őƛƴƛ 

ǇƻƎƻŘƴƛƳ Ȋŀ ȊŀƘǘƧŜǾƴƛƧŜ ǇǊƛƳƧŜƴŜ ƎŘƧŜ ƧŜ ǇƻǘǊŜōƴƻ ǾƻŘƛǘƛ Ǌŀőǳƴŀ ƻ ǾŜŏŜƳ ōǊƻƧǳ ȊŀŘŀǘŀƪŀΦ 
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2.2 Izvori napajanja 

¦ ǇǊƻƧŜƪǘǳ ƧŜ ƪƻǊƛǑŏŜƴ ƻƭƻǾƴƛ ŀƪǳƳǳƭŀǘƻǊ ǇǊƻƛȊǾƻŚŀőŀ Ultracell ς UL 4-12 (12V 4AH/20HR) i 

ǎƻƭŀǊƴŀ Ǉƭƻőŀ ǎƴŀƎŜ р² ƪƻƧŀ ƴŀ ǎǳƴőŜǾƻƧ ǎǾƧŜǘƭƻǎǘƛ ŘŀƧŜ ƴŀǇƻƴ ƻŘ ƻƪƻ нл±Φ 

 

2.2.1 9ƭŜƪǘǊƛőƴŀ ǑŜƳŀ ǎƛǎǘŜƳŀ napajanja 
 

{ƛǎǘŜƳ ǎŜ ƪƻƴǘǊƻƭƛǑŜ ǇƻƳƻŏǳ ŘǾŀ ǇǊŜƪƛŘŀőŀ ς P1 i P2 (slika 2.2)Φ tǊŜƪƛŘŀő tм ǳƪƭƧǳőǳƧŜ ŀƪǳƳǳƭŀǘƻǊ 

ǳ ƪƻƭƻΣ őƛƳŜ ƧŜ ƻƳƻƎǳŏŜƴƻ ƛ ƴƧŜƎƻǾƻ ǇǳƴƧŜƴƧŜΦ tǊŜƪƛŘŀő tн ǳǇǊŀǾƭƧŀ ǊŀŘƻƳ ǊŜƎǳƭŀǘƻǊŀ ƴŀǇƻƴŀ [тулрΣ 

Ǒǘƻ ƻŘǊŜŚǳƧŜ Řŀ ƭƛ ŏŜ ƴŀ ƴƧŜƎƻǾƻƳ ƛȊƭŀȊǳ ōƛǘƛ ƴŀǇƻƴŀΦ Regulator LM7805 na izlazu daje konstantni 

napon od 5V i struju 1,5A za vrijednost ulaznog napona od 7-25V, pa je Ȋŀǘƻ ǎŀǾǊǑŜƴ Ȋŀ ǊŀŘ Ȋŀ 

mikrokontrolerima. 

5ǊǳƎƛ ǊŜƎǳƭŀǘƻǊ ƴŀǇƻƴŀ ƪƻƧƛ ƧŜ ƪƻǊƛǑŏŜƴ ƧŜ [aомт, ƛ ƻƴ ǎƭǳȌƛ Ȋŀ ǎǇǳǑǘŀƴƧŜ ƴŀǇƻƴŀ ǎƻƭŀǊƴŜ ǇƭƻőŜ na 

prihvatljivi nivo za punjenje akumulatora. U stanju je da na izlazu da napon od 1,25-от± ƛ ǎǘǊǳƧǳ ǾŜŏǳ 

od 1.5A, a ǇƻŘŜǑŀǾŀ ǎŜ ǇƻƳƻŏǳ ǎŀƳƻ ŘǾŀ ƻǘǇƻǊƴƛƪŀ ς ǳ ƻǾƻƳ ǎƭǳőŀƧǳ ƻǘǇƻǊƴƛƪƻƳ w2 i 

potenciometrom R1. tƻŘŜǑŜƴ ƧŜ ǘŀƪƻ Řŀ ŘŀƧŜ ƴŀǇƻƴ ƻŘ мо±, koji bi nakon slabljenja na Cenerovoj 

diodi D1 od oko 0,4V ƴŀŘƧŀőŀƻ ƴŀǇƻƴ ƴŀ ŀƪǳƳǳƭŀǘƻǊǳ ƛ ǘŀƪƻ ȊŀǇƻőŜƻ ƴƧŜƎƻǾƻ ǇǳƴƧŜƴƧŜΣ ǳƧŜŘƴƻ 

ƴŀǇŀƧŀƧǳŏƛ ǊŜƎǳƭŀǘƻǊ [тулрΦ 

 

Slika 2ΦнΥ 9ƭŜƪǘǊƛőƴŀ ǑŜƳŀ ǎƛǎǘŜƳŀ Ȋŀ ƴŀǇŀƧŀƴƧŜ 
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5ƛƻŘŀ 5н ǎǇǳǑǘŀ ƴŀǇƻƴ ƪŀ ōŀȊƛ Ȋŀ у±Φ 5ŀ ōƛ ǘǊŀƴȊƛǎǘƻǊ ¢ ǇǊƻǾŜƻΣ ǇŀŘ ƴŀǇƻƴŀ ƴŀ ƻǘǇƻǊƴƛƪǳ wп ƴŜ 

ǎƳƛƧŜ Řŀ ōǳŘŜ ǾŜŏƛ ƻŘ п±Σ Ǒǘƻ ƻŘƎƻǾŀǊŀ ǎǘǊǳƧƛ ōŀȊŜ ƻŘ пƳ!Φ {ǘǊǳƧŀ LŀŘƧ ƳƻȌŜ Řŀ ǎŜ ƪǊŜŏŜ ǳ ƻǇǎŜƎǳ ƻŘ 

50-100˃ !Σ Řƻƪ je nŀǇƻƴ ƴŀ ƻǘǇƻǊƴƛƪǳ wн όƛȊƳŜŚǳ ǇǊƛƪƭƧǳőŀƪŀ !5W i VO) konstantan i iznosi 1,25V 

(dato je u specifikacijama regulatora), Ǒǘƻ ƻǎƛƎǳǊŀǾŀ Řŀ ƴŀǇƻƴ ƴŀ ƪƻƭŜƪǘƻǊǳ ōǳŘŜ ǳǾƛƧŜƪ ǾŜŏƛ ƻŘ 

napona na bazi όƛ ǳ ƻǾƻƳ ǎƭǳőŀƧǳ ƧŜŘƴŀƪ ммΣтр±ύΦ ¢ƻ Ȋƴŀőƛ Řŀ ǘǊŀƴȊƛǎǘƻǊ ǊŀŘƛ ǳ ŘƛǊŜƪǘƴƻƳ ŀƪǘƛǾƴƻƳ 

ǊŜȌƛƳǳ ό±Ŏ Ҕ ±ō Ҕ ±ŜύΦ U tom ǎƭǳőŀƧǳ ƳƻȌŜƳƻ ȊŀƴŜƳŀǊƛǘƛ ǎǘǊǳƧǳ ƪǊƻȊ ƎǊŀƴǳ ǳ ƪƻƧƻƧ ǎŜ ƴŀƭŀȊƛ ōŀȊŀ 

ǘǊŀƴȊƛǎǘƻǊŀΣ ȊōƻƎ őŜƎŀ ǎŜ ƧŀǎƴƛƧŜ ǾƛŘƛ Řŀ ƧŜ ƴƧŜƎƻǾŀ ǳƭƻƎŀ ƻŘǾƻŚŜƴƧŜ ǾƛǑƪŀ ƛȊƭŀȊƴŜ ǎǘǊǳƧŜ ƴŀ ƳŀǎǳΣ ƪŀƪƻ 

ōƛ ǎŜ ŀƪǳƳǳƭŀǘƻǊ Ǉǳƴƛƻ ǎǇƻǊƛƧŜ ƛ ǘŀƪƻ ŘǳȌŜ ǘǊŀƧŀƻΦ 

 

2.3 YƻǊƛǑŏŜƴƛ ǎenzori 

tƻǎƭƧŜŘƴƧŜ ǾǊƛƧŜƳŜ ƪŀǊŀƪǘŜǊƛǑŜ ǎǾŜ ǾŜŏŀ ǇƻǇǳƭŀǊƴƻǎǘ ƛ ǇǊƛǎǘǳǇŀőƴƻǎǘ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊǎƪŜ 

elektronike, koja lako nalazi put do: amatera, studenata, pa i profesionalaca. Velikim izborom 

mikrokontrolera (Arduino, ESP32, Raspberry Pi...) ƧŜ ƻōǳƘǾŀŏŜƴ ǑƛǊƻƪƛ ǎǇŜƪǘŀǊ ǊŀȊƭƛőƛǘƛƘ ǇǊƛƳƧŜƴŀΦ 

¢ŀƪƻ ǎŜ ƳƻƎǳ ƴŀŏƛ ƴŀƧǊŀȊƭƛőƛǘƛƧƛ ǎŜƴȊƻǊƛ ƛ ǇŜǊƛŦŜǊƛƧŜ Ǉƻ ƴƛǎƪƛƳ ŎƛƧŜƴŀƳŀΦ hŘ ƪƻƳŜǊŎƛƧŀƭƴƛƘ ǊƧŜǑŜƴƧŀ ƧŜ ǳ 

ƻǾƻƳ ǊŀŘǳ ƪƻǊƛǑŏŜƴ senzor DHT11 ƪƻƧƛ ƳƧŜǊƛ ǘŜƳǇŜǊŀǘǳǊǳ ƛ ǾƭŀȌƴƻǎǘ ǾŀȊŘǳƘŀΦ {ŜƴȊƻǊ ǾƭŀȌƴƻǎǘƛ 

ȊŜƳƭƧƛǑǘŀ ŏŜ ōƛǘƛ ŘŜǘŀƭƧƴƛƧŜ ƻǇƛǎŀƴ u poglavlju 5 ƧŜǊ ǇǊŜŘǎǘŀǾƭƧŀ ƻǊƛƎƛƴŀƭƴƻ ǊƧŜǑŜƴƧŜΣ ƴŀǎǘŀƭƻ ǘƻƪƻƳ 

razvoja ovog rada. 

Senzor DHT11 ǎǇŀŘŀ ǳ ŘƛƎƛǘŀƭƴǳ ǾǊǎǘǳ ǎŜƴȊƻǊŀΦ {ŀŘǊȌƛ ƪŀǇŀŎƛǘƛǾƴƛ ǎŜƴȊƻǊ ǾƭŀȌƴƻǎǘƛ ƛ ǘŜǊƳƛǎǘƻǊ Ȋŀ 

mjerenje okolnog vazduha, i prenosi digitalne poŘŀǘƪŜ ǇǳǘŜƳ Ȋŀ ǘƻ ƴŀƳƛƧŜƴƧŜƴŜ ƴƻȌƛŎŜ όǇƛƴŀύΦ hƴ 

ƳƻȌŜ Řŀ ǎŜ ƴŀǇŀƧŀ ƴŀǇƻƴƻƳ ǳ ƻǇǎŜƎǳ ƻŘ о-р±Σ Ǒǘƻ ǇƻŘǊȌŀǾŀƧǳ ǎǾƛ ǇƻȊƴŀǘƛƧƛ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊƛΦ hǇǎŜƎ 

mjerenja temperature iznosi od 0-50 °C ǳȊ ǘŀőƴƻǎǘ ƻŘ ±2°CΣ ŀ ƻǇǎŜƎ ǾƭŀȌƴƻǎǘƛ ƛȊƴƻǎƛ 20-80% pri 

ǘŀőƴƻǎǘƛ ƻŘ р҈Φ tƻŘŀŎƛ ǎŜ ƴŀ ƴƧŜƳǳ ƳƻƎǳ ƻőƛǘŀǘƛ ǳ ǊŀȊƳŀƪǳ ƻŘ ƴŀƧƳŀƴƧŜ ŘǾƛƧŜ ǎŜƪǳƴŘŜΣ ŀ ƴƧŜƎƻǾŀ 

ǾŜƭƛőƛƴŀ ƛȊƴƻǎƛ мрΣр Ȅ мн Ȅ рΣр ƳƳΦ 5ƻƭŀȊƛ ǳ ƪǳŏƛǑǘǳ ǎŀ ǘǊƛ ƛƭƛ őŜǘƛǊƛ ƪƻƴǘŀƪǘŀ ς od kojih se tri koriste, I to 

ŘǾŀ Ȋŀ ƴŀǇŀƧŀƴƧŜ ƛ ƧŜŘŀƴ Ȋŀ ǇǊŜƴƻǎ ǇƻŘŀǘŀƪŀΦ bŜǑǘƻ ōƻƭƧƛ Ǉƻ ǇƛǘŀƴƧu performansi je njegov nasljednik 

ς DHT22, koji je i skuplji. Na slici 2.3 je prikazan senzor  DHT11 ƴŀ ŜƪǎǇŜǊƛƳŜƴǘŀƭƴƻƧ ǇƭƻőƛΦ 

 

 

Slika 2.3: Senzor DHT11 
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2.4 Arduino IDE 

bŀƧǇǊƛƧŜ ƧŜ ǇƻǘǊŜōƴƻ ƛƴǎǘŀƭƛǊŀǘƛ ǊŀȊǾƻƧƴƻ ƻƪǊǳȌŜƴƧŜ Arduino IDE (engl. Integrated Development 

Environment ς ƛƴǘŜƎǊƛǎŀƴƻ ǊŀȊǾƻƧƴƻ ƻƪǊǳȌŜƴƧŜύ Ȋŀ ƻŘƎƻǾŀǊŀƧǳŏƛ ƻǇŜǊŀǘƛǾƴƛ ǎƛǎǘŜƳΣ ǇǊŀǘŜŏƛ ǳǇǳǘǎǘǾƻ ǎŀ 

ȊǾŀƴƛőƴƻƎ ǎŀƧǘŀΥ https://www.arduino.cc/en/softwareΦ {ƻŦǘǾŜǊ ƧŜ ōŜǎǇƭŀǘŀƴΣ ǳȊ ƳƻƎǳŏƴƻǎǘ ŘƻƴƛǊŀƴƧŀ 

ǇǊƻƛȊǾƻŚŀőǳΦ LƴǎǘŀƭŀŎƛƧŀ ƧŜ ƧŜŘƴƻǎǘŀǾƴŀ ƛ őƛǎǘŀΣ ƛ ƴŜ ǎŀŘǊȌƛ ǊŜƪƭŀƳƛǊŀƴƧŜ ŘƻŘŀǘƴƻƎ ǎƻŦǘǾŜǊŀΦ 

Slika 2.4Υ tǊƛǎǘǳǇŀƴƧŜ ǇƻŘŜǑŀǾŀƴƧƛƳŀ 

 

Da bi mikrokontroler LoRa 32(V2) ƳƻƎŀƻ Řŀ ǎŜ ǇǊƻƎǊŀƳƛǊŀ ǳ ǊŀȊǾƻƧƴƻƳ ƻƪǊǳȌŜƴƧǳ Arduino, 

ǇƻǘǊŜōƴƻ ƧŜ ƛƴǎǘŀƭƛǊŀǘƛ Ǉƭƻőǳ ǳƴǳǘŀǊ ǳǇǊŀǾƭƧŀőŀ ǇƭƻőŀƳŀ (Arduino Boards Manager). On se nalazi u 

meniju File > Preferences (slika 2.4). Zatim u polju Additional Boards Manager URLs (Slika 2.5) treba 

ǳƴƛƧŜǘƛ ǎƭŜŘŜŏǳ ŀŘǊŜǎǳΥ https://resource.heltec.cn/download/package_heltec_esp32_index.json. 

Slika 2.5Υ ¦ƴƻǑŜƴƧŜ ŀŘǊŜǎŜ Ȋŀ ƻŘƎƻǾŀǊŀƧǳŏǳ Ǉƭƻőǳ 

 

https://www.arduino.cc/en/software
https://resource.heltec.cn/download/package_heltec_esp32_index.json
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bŀƪƻƴ ǘƻƎŀ ǎŜ ƳƻȌŜ ƛƴǎǘŀƭƛǊŀǘƛ Ǉƭƻőŀ Heltec ESP32, pritiskom na Tools > Board > Boards Manager 

(Slike 2.5 i 2.7). U polju za pretragu unijeti Heltec ESP32, i pritiskom na dugme Install ȊŀǇƻőƛƴƧŜ 

ƛƴǎǘŀƭŀŎƛƧŀ ƪƻƧŀ ƳƻȌŜ ǇƻǘǊŀƧŀǘƛ ƴŜƪƻƭƛƪƻ minuta. 

Slika 2.6Υ tǊƛǎǘǳǇŀƴƧŜ ǳǇǊŀǾƭƧŀőǳ ǇƭƻőŀƳŀ 

Slika 2.7Υ ¦ǇǊŀǾƭƧŀő ǇƭƻőŀƳŀ 

 

Naredni korak je instaliranje biblioteke Heltec ESP32. Odabirom Sketch > Include Library > 

Manage Libraries, ŘƻƭŀȊƛ ǎŜ Řƻ ǳǇǊŀǾƭƧŀőŀ ōƛōƭƛƻǘŜƪŀƳŀ (Library Manager) ς Slika 2.8, ƪƻƧƛ ƧŜ ǎƭƛőŀƴ 

ǳǇǊŀǾƭƧŀőǳ ǇƭƻőŀƳŀ (Boards Manager). Unosom Heltec ESP32 ǳ ǇƻƭƧǳ Ȋŀ ǇǊŜǘǊŀƎǳΣ ŦƛƭǘǊƛǊŀŏŜ ǎŜ 

biblioteka Heltec ESP32 Dev-Boards by Heltec Automation. Pritiskom na dugme InstallΣ ōƛŏŜ 

instalirana vrlo brzo. 
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Slika 2.8Υ ¦ǇǊŀǾƭƧŀő ōƛōƭƛƻǘŜƪŀƳŀ 

 

YŀŘŀ ƧŜ ƛ ǘƻ ǳǎǇƧŜǑƴƻ ȊŀǾǊǑŜƴƻΣ Ǉƭƻőŀ LoRa 32(V2) ǎŜ ƳƻȌŜ ǇǊƻƎǊŀƳƛǊŀǘƛ ƪŀƻ ƛ ōƛƭƻ ƪƻƧŀ Arduino 

ǇƭƻőŀΣ ƻŘŀōƛǊƻƳ ƴŀ Tools > Board > WiFi LoRa 32(V2) ƛ ƻŘƎƻǾŀǊŀƧǳŏŜƎ ǇƻǊǘŀΣ Ǒǘƻ ƧŜ Řŀǘƻ na slici 2.9. 

wŀȊƭƛƪŀ ƧŜ ƧŜŘƛƴƻ ǳ ǊŀǎǇƻǊŜŘǳ ƛ ƴŀƳƧŜƴƛ ǇƛƴƻǾŀ ƛ ŦǳƴƪŎƛƻƴŀƭƴƻǎǘƛ ƪƻƧŜ ƪŀǊŀƪǘŜǊƛǑǳ ǎǾŀƪǳ ǇƭƻőǳΣ Ǉŀ 

programski ƪƻŘ ǘǊŜōŀ ǇǊƛƭŀƎƻŘƛǘƛ ŘŀǘƛƳ ǳǎƭƻǾƛƳŀ ƛ ƳƻƎǳŏƴƻǎǘƛƳŀ ǎŀƳƻƎ ƳƛƪǊƻƪƻƴǘǊƻƭŜǊŀΦ 
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Slika 2.9Υ hŘŀōƛǊ ǇƭƻőŜ ²ƛCƛ [ƻwŀ онό±нύ 

 

¦ǇǳǘǎǘǾƻ ƧŜ Ǉƛǎŀƴƻ Ȋŀ ǾŜǊȊƛƧǳ ǊŀȊǾƻƧƴƻƎ ƻƪǊǳȌŜƴƧŀ Arduino 1.8.13, dok kod drugih ǾŜǊȊƛƧŀ ƳƻȌŜ 

Řƻŏƛ Řƻ ƴŜȊƴŀǘƴƛƘ ƻŘǎǘǳǇŀƴƧŀ ǳ ǊŀǎǇƻǊŜŘǳ ƪƻƳŀƴŘƛ ǳ ƎǊŀŦƛőƪƻ-ƪƻǊƛǎƴƛőƪƻƳ ƛƴǘŜǊŦŜƧǎǳΦ 

 

LLL tǊƻǘƻƪƻƭ [ƻwŀ²!b 
 

3.1 Osnovni podaci 

LoRaWAN je WAN protokol male snage (Low Power Wide Area Networking)Σ ƻǎƳƛǑƭƧŜƴ ǎŀ ŎƛƭƧŜƳ 

ōŜȌƛőƴƻƎ ǇƻǾŜȊƛǾŀƴƧŀ ƴŀ ƛƴǘŜǊƴŜǘ ǳǊŜŚŀƧŀ ǎŀ ōŀǘŜǊƛƧǎƪƛƳ ƛȊǾƻǊƻƳ ƴŀǇŀƧŀƴƧŀΣ ƛ ŎƛƭƧŀ ƎƭŀǾƴŜ ȊŀƘǘƧŜǾŜ 

Internet of Things (IoT)Σ ƪŀƻ Ǒǘƻ ǎǳΥ ŘǾƻǎƳƧŜǊƴŀ ƪƻƳǳƴƛƪŀŎƛƧŀΣ ōŜȊōƧŜŘƴƻǎǘ ǇǊŜƴƻǎŀ podataka, 

mobilnost i usluge lokalizacije. 

LȊŀ ƴƧŜƎŀ ǎǘƻƧƛ ƴŜǇǊƻŦƛǘƴƻ ǳŘǊǳȌŜƴƧŜ ƻǘǾƻǊŜƴƻƎ ǘƛǇŀ LoRa AllianceΣ ƪƻƧŜ ƧŜ ǇƻőŜƭƻ ǎŀ ǊŀŘƻƳ ǳ 

martu 2015. godine. 

LoRa ƧŜ ŦƛȊƛőƪƛ ǎƭƻƧ ōŜȌƛőƴŜ ƳƻŘǳƭŀŎƛƧŜ ƪƻƧƛ ǎŜ ƪƻǊƛǎǘƛ Ȋŀ ǎǘǾŀǊŀƴƧŜ ǇƻǎǊŜŘƴƛƪŀ Ȋŀ ƪƻƳǳƴƛƪŀŎƛƧǳ 

ǾŜƭƛƪƻƎ ƻǇǎŜƎŀΦ aƴƻƎƛ ǇǊŜǾŀȊƛŚŜƴƛ ōŜȌƛőƴƛ ǎƛǎǘŜƳƛ ƪƻƧƛ ǎǳ ǳ ǑƛǊƻƪƻƧ ǳǇƻǘǊŜōƛ ƪƻǊƛǎǘŜ ŦǊŜƪǾŜƴŎƛƧǎƪǳ 

modulaciju (frequency shift keying ς FSK) ƪŀƻ ŦƛȊƛőƪƛ ƴƛǾƻΣ ƧŜǊ Ƨe ona veoma pogodna za malu 

ǇƻǘǊƻǑƴƧǳΦ LoRa ƧŜ ȊŀǎƴƻǾŀƴ ƴŀ άŎǾǊƪǳǘƴƻƧέ ǎǇǊŜƪǘǊŀƭƴƻƧ ƳƻŘǳƭŀŎƛƧƛ (chirp spread spectrum 

modulation ς CSS)Σ ƪƻƧŀ ƛƳŀ ƛǎǘŜ ƪŀǊŀƪǘŜǊƛǎǘƛƪŜ ƳŀƭŜ ǎƴŀƎŜ ƪŀƻ ƛ C{Y ƳƻŘǳƭŀŎƛƧŀΣ Řƻƪ ȊƴŀőŀƧƴƻ 

ǇƻǾŜŏŀǾŀ ŘƻƳŜǘ ƪƻƳǳƴƛƪŀŎƛƧŜΦ CSS ǎŜ ǾŜŏ ŘŜŎŜnijama koristi u vojnoj i svemirskoj komunikaciji zbog 

ǾŜƭƛƪŜ ŘŀƭƧƛƴŜ ƪƻƧŀ ǎŜ ǇƻǎǘƛȌŜ ƛ ƻǘǇƻǊƴƻǎǘƛ ƴŀ ǎƳŜǘƴƧŜΣ ŀ [ƻwŀ ƧŜ ǇǊǾŀ ƧŜŦǘƛƴŀ ƛƳǇƭŜƳŜƴǘŀŎƛƧŀ 

namijenjena komercijalnoj upotrebi. 


























































